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1 Overview
“Setting File Creation Software for North America” creates a setting file to be used for the air-conditioning 
management system.
The created data file is uploaded to each system by using upload function.

CAUTION

2 System requirements
The following shows the ideal system requirements for this software.

The following runtime library is required:
• Microsoft® .NET Framework 2.0 SP2

• “Windows XP”, “Windows Vista”, “Windows 7”, “Windows 8”, and “Microsoft office” are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and / or other countries.

• Adobe, the Adobe logo, Reader, and Acrobat are either registered trademarks or trademarks of Adobe Systems 
Incorporated in the United States and / or other countries.

• InstallShield is either a registered trademark or trademark of Flexera Software Inc. in the United States and / or 
other countries.

• All other company and product names are either registered trademarks or trademarks of the respective owners. 
In this manual such names are not indicated by ™, ® or © marks.

“Setting File Creation Software for North America” and “Setting File Creation Software for North America” (UL-approved 
system) appeared on the screen shots in this manual are the names of a software represent the same software. 
However, some functions are restricted. Refer to the “Operating Instructions” for the details.

Item Specifications
Operating System Windows 7, Windows 8, 8.1

Office Office 2003, Office 2007, Office 2010
– 5 –
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3 Creating a setting file

Workflow of the software
The following flowchart shows the process of creating data with Setting File Creation Software for North America:

Start Setting File Creation Software for North America

Create data Edit data

Select a file

Set up system data

Set up a server / interface

Set up outdoor units / indoor units / zone / demand

Select a system
6-EN– 6 –
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Data upload
The following flowchart shows the process of uploading data created with Setting File Creation Software for North 
America:

Start Setting File Creation Software for North America

Start from the data input main screen Start from the main menu screen

Select setting file data

Upload

Select a setting file folder

Select a target system

Specify IP address

PING test

Restart to finish uploading
Check uploaded data and perform the test run
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4 Note on using Setting File Creation Software 
for North America

Selectable outdoor units / indoor units differ depending on the frequency and region setting. The frequency of an 
already created file cannot be changed.

CAUTION
Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).
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5 Features of Setting File Creation Software 
for North America

Creating / editing a setting file
You can create a setting file and edit it.

Fig.1 [Main Menu] screen
– 9 –
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Selecting a North America
When creating a new setting file, select a target North America.

Fig.2 [Select System] screen

Creating / editing data of a setting file

Setting Up System Data
Set up data of the entire system selected on the Select System screen (Fig.2)

Fig.3 [System] screen
10-EN– 10 –



11-EN

Setting File Creation Software for North America Operating Instructions
Setting Up a Server / Interface
Set up a server / interface. The Server / Interface screen consists of the Server Setting tab, the Interface Address 
tab, and the Interface Setting tab.

Fig.4 [Server / Interface] screen
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Setting Up Outdoor Units
Set up data of outdoor units.

Fig.5 [Outdoor] screen
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Setting Up the Zone
Set up the zone. The Zone screen consists of the zone combo box and zone name list.

Fig.6 [Zone] screen
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Setting Up Indoor Units
Set up data of indoor units.

Fig.7 [Indoor] screen
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Setting Up the Demand
Set up the demand alarm input of indoor units. This setting is only available for Smart BMS Manager.

Fig.8 [Demand] screen

Setting Up the Zone Names
Set up the zone names. This setting is only available for Smart BMS Manager.

Fig.9 [Set Tree Name] screen
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Checking the Version Information
Select the [Help] menu then [About] to display the version information.

Fig.10 [Help] menu (About)

Fig.11 [About] screen
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Uploading a setting file to the server
Specify a setting file data, its folder, the target system and IP address, then upload the file.

Fig.12 [Upload Settings] screen

The following screen is displayed during upload to show the upload progress screen.

Fig.13 [Upload Progress] screen
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6 Using the Setting File Creation Software for 
North America

Starting / exiting the Setting File Creation Software for North 
America

Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1. Start the Setting File Creation Software for North America.

• Desktop icon
Double-click the desktop icon.

Fig.14 Setting File Creation Software for North America desktop icon

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

2. The startup screen appears.
The startup screen appears.

Fig.15 Startup screen

3. Setting File Creation Software for North America Startup Complete
The startup screen (Fig.15) disappears, and the Main Menu screen (Fig.1) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
18-EN– 18 –
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.16 [Main Menu] screen (Close button)

Fig.17 [Main Menu] screen (Exit button)

Fig.18 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.19 Exit confirmation dialog box

Click button

Click button
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Creating new data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.2) appears.

Fig.20 [Main Menu] screen (New button 1)

Fig.21 [Main Menu] screen (New button 2)

Fig.22 [Main Menu] screen (New menu)

Click button

Click button
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Selecting a file to edit data
Click the [Select File] button, or select the [File] menu then [Open]. The Open screen appears.

Fig.23 [Main Menu] screen (Select File button)

Fig.24 [Main Menu] screen (Open button)

Fig.25 [Main Menu] screen (Open menu)

Click button

Click button
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When the Open screen has opened, select a file to edit. The System screen (Fig.3) appears.

Fig.26 [Open] screen
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Using a history file to edit data
Double-click a line in the History List, or select a file from Recently Used File. The System screen (Fig.3) appears.

Fig.27 [Main Menu] screen (History List)

Double-click
– 23 –
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Up to 9 files are stored in Recently Used File.

Fig.28 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.29 Warning message box
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Setting up the system
Select the [System] tab and configure the settings.

Fig.30 [System] tab

The following table shows how to enter / select data:
Smart BMS Manager

Item Data type Selection Note
Building name Entered by user –

Indoor unit total Q'ty Entered by user Numeric value only

Daily report closing time Entered by user Time only

Monthly report closing date Entered by user Numeric value only

Lock Linkage Mode Selected by user Select from list Smart BMS Manager only

Date display format Selected by user Select from list Smart BMS Manager only

Starting day of the week Selected by user Select from list Smart BMS Manager only

Energy Monitoring Selected by user Select from list

Stand-by power counting Selected by user Select from list

Words in error code definition file 
and zone name tags Selected by user Select from list Smart BMS Manager only

Temperature display: Interval Selected by user Select from list

Temperature display: C./F. Selected by user Select from list

CONTACT Info. Entered by user –

Table.1 How to enter / select data
– 25 –
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Setting up the server
Select the [Server Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.31 [Server Setting] tab

The following table shows how to enter / select data:
Smart BMS Manager

CAUTION

Item Data type Selection Note
IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

Digital I/O Relay Interface Q'ty Entered by user Numeric value only 0 - 4

Energy Monitoring Relay 
Interface Q'ty Entered by user Numeric value only 0 - 4

Table.2 How to enter / select data

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).
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Setting up the interface address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.32 [Interface Address] tab

The following table shows how to enter / select data:
Smart BMS Manager

Item Data type Selection Note
Energy Monitoring Relay 
Interface Address Data Entered by user Numeric value only

Digital I/O Relay Interface 
Address Data Entered by user Numeric value only

Table.3 How to enter / select data
– 27 –
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Setting up the interface function
Select the [Interface Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.33 [Interface Setting] tab

The following table shows how to enter / select data:
Smart BMS Manager

Item Data type Selection Note
I/O Function Selected by user Select from list

Signal logic Selected by user Select from list Digital I/O Interface Only

Pulse constants Entered by user Numeric value only
0.1 – 99.9, Energy
Monitoring Relay Interface 
Only

Table.4 How to enter / select data
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Adding an outdoor unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor
unit list.

Fig.34 [Outdoor] tab (New button)

Fig.35 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Smart BMS Manager

Item Data type Selection Note
LINE No Selected by user Select from list

Line address Entered by user Numeric value only

Outdoor unit combination model 
name Selected by user Select from the Select 

outdoor unit model screen

Outdoor unit model name Cannot be edited

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Power meter input name Selected by user Select from list

Table.5 How to enter / select data

Click button
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Selecting an outdoor unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.5) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. “Outdoor unit combination model name,” “Outdoor unit model name,” and “Outdoor unit address” will 
automatically become available on the [Outdoor] tab (Fig.5). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.36 [Select outdoor unit model] screen
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Copying the data of an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address” and “Outdoor name” will automatically be increased in one.

Fig.37 [Outdoor] tab (Copy button)

Fig.38 [Outdoor] tab (Copy menu)

Click button
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Copying the data of multiple outdoor units
Select a line of outdoor unit on the [Outdoor] tab (Fig.5), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.39 [Outdoor] tab (Multicopy button)

Fig.40 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” and “Outdoor name” will automatically be increased in one.

Fig.41 [Copy line count] screen

Click button
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Deleting the data of outdoor units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.5), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.42 [Outdoor] tab (Delete button)

Fig.43 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.44 Deletion confirmation dialog box

Click button
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Inserting an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.45 [Outdoor] tab (Insert button)

Fig.46 [Outdoor] tab (Insert menu)

Click button
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Editing a zone
On the [Zone] tab, select a section (Floor, Monthly report tenant, Tenant, Area) from the combo box in the upper 
left corner of the window. Enter a name in the displayed zone list.

Fig.47 [Zone] tab (Floor)

Fig.48 [Zone] tab (Monthly report tenant)

Click
– 35 –
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Fig.49 [Zone] tab (Tenant)

Fig.50 [Zone] tab (Area)
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Adding a zone
Click the [New] button, or select the [Operation] menu > [Tree] > [New]. A line will be added to the zone list.

Fig.51 [Zone] tab (New button)

Fig.52 [Zone] tab (New button)

The following table shows how to enter / select data:
Smart BMS Manager

Item Data type Selection Note
Name Entered by user

Tally Classifications Selected by user Select from list Monthly report tenant only

Monthly report tenant name Selected by user Select from list Tenant only

Table.6 How to enter / select data

Click button
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Copying the data of a zone
Select a line of a zone on the [Zone] tab, and click the [Copy] button, or select the [Operation] menu > [Tree] > 
[Copy]. The copied zone will be added to the zone list. The number of the copied “Name” will automatically be 
increased in one.

Fig.53 [Zone] tab (Copy button)

Fig.54 [Zone] tab (Copy menu)

Click button
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Copying the data of multiple zones
Select a line of zone on the [Zone] tab, and click the [Multicopy] button, or select the [Operation] menu > [Tree] > 
[Multicopy]. The Copy line count screen appears.

Fig.55 [Zone] tab (Multicopy button)

Fig.56 [Zone] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied zones will be added to the zone list. The number of the 
copied “Name” will automatically be increased in one.

Fig.57 [Copy line count] screen

Click button
– 39 –
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Deleting the data of zones
Select one or more lines of zones on the [Zone] tab (Fig.6), and click the [Delete] button, or select the [Operation] 
menu > [Tree] > [Delete].

Fig.58 [Zone] tab (Delete button)

Fig.59 [Zone] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The zones will be deleted from the zone list. To cancel deletion, click the Cancel 
button.

Fig.60 Deletion confirmation dialog box

Note that the following data will also be deleted if a zone is deleted:
• The Zone setting of an indoor unit set to the deleted zone

Click button
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Inserting a zone
Select a line of a zone on the [Zone] tab (Fig.6), and click the [Insert] button, or select the [Operation] menu > [Tree] 
> [Insert]. A line will be inserted at the selected location in the zone list.

Fig.61 [Zone] tab (Insert button)

Fig.62 [Zone] tab (Insert menu)

Click button
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Renumbering the zones
Click the [Renumber] button, or select the [Operation] menu > [Tree] > [Renumber]. The numbers in the “No” 
column will be reassigned.

Fig.63 [Zone] tab (Renumber button)

Fig.64 [Zone] tab (Renumber menu)

Click button
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Changing the order of the zones
Select a line of a zone on the [Zone] tab, and click the [Up] / [Down] button, or select the [Operation] menu > [Tree] 
> [Up] / [Down]. The selected line moves up or down.

Fig.65 [Zone] tab (Up button)

Fig.65-1 [Zone] tab (Down button)

Fig.66 [Zone] tab (Up menu)

Fig.66-1 [Zone] tab (Down menu)

Click button

Click button
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Adding an indoor unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.67 [Indoor] tab (New button)

Fig.68 [Indoor] tab (New menu)

Click button
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The following table shows how to enter / select data:
Smart BMS Manager

Item Data type Selection Note
LINE No Selected by user Select from list

Line Address Entered by user

Indoor unit address Entered by user

Parent Indoor Unit No. Entered by user

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Floor name Selected by user Select from list

Tenant name Selected by user Select from list

Area name Selected by user Select from list

Door-lock input name Selected by user Select from list

Fire alarm input name Selected by user Select from list

Power meter input name Selected by user Select from list

General purpose interface Energy 
Coefficient (kWh) Entered by user

Air Conditioner No. Entered by user

Table.7 How to enter / select data
– 45 –
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Selecting an Indoor Unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.7) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. “Indoor unit 
model name” will automatically become available on the [Indoor] tab (Fig.7). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.69 [Select indoor unit model] screen
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Copying the data of an indoor unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.70 [Indoor] tab (Copy button)

Fig.71 [Indoor] tab (Copy menu)

Click button
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Copying the data of multiple indoor units
Select a line of indoor unit on the [Indoor] tab (Fig.7), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.72 [Indoor] tab (Multicopy button)

Fig.73 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.74 [Copy line count] screen

Click button
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Deleting the indoor units
Select one or more lines of indoor units on the [Indoor] tab (Fig.7), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.75 [Indoor] tab (Delete button)

Fig.76 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.77 Deletion confirmation dialog box

Click button
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Inserting an indoor unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.78 [Indoor] tab (Insert button)

Fig.79 [Indoor] tab (Insert menu)

Click button
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Changing the order of the indoor units
Select a line of an indoor unit on the [Indoor] tab, and click the [Up] / [Down] button, or select the [Operation] menu 
> [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.80 [Indoor Unit] tab (Up button)

Fig.80-1 [Indoor Unit] tab (Down button)

Fig.81 [Indoor Unit] tab (Up menu)

Fig.81-1 [Indoor Unit] tab (Down menu)

Click button

Click button
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Deleting all air conditioner No. of the indoor units
Click the [Clear] button, or select the [Operation] menu > [Indoor Unit] > [Clear]. All the Air Conditioner No. will be 
deleted.

Fig.82 [Indoor Unit] tab (Clear button)

Fig.83 [Indoor Unit] tab (Clear menu)

Click button
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Setting up the demand alarm
Select the [Demand] tab, select a demand device, and set up the demand alarm.

Fig.84 [Demand] tab (Indoor)
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Setting / canceling the demand alarm input
The information of the indoor units appears in the Demand list. Select an control mode of the demand alarm from 
the combo box.

Fig.85 [Demand] tab (Control Mode selection)

Select one or more demand alarm input names.

Fig.86 [Demand] tab (Demand Alarm input name selection)
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Clicking the [Set] button sets the selected demand alarm names to the selected input mode.

Fig.87 [Demand] tab (Set)

Clicking the [Cancel] button sets the selected demand alarm names to “No setting”.

Fig.88 [Demand] tab (Cancel)

The selected control 
mode is set

“No setting” is set
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Saving created data to a file
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.89 [Save] button

Fig.90 [Save Setting File] menu

Fig.91 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.92 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.93 Overwrite confirmation dialog box
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.94 [Output File] button

Fig.95 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.96 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.97 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the
section containing the error.

Fig.98 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and
click the OK button. The upload screen appears.

Fig.99 DEF file output complete dialog box
– 59 –



EN

Setting File Creation Software for North America Operating Instructions
Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.100 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.101 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Uploading a setting file (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.1) or [Data Input 
Main] screen (Fig.3). The Upload Settings screen (Fig.13) appears.

Fig.102 [Main Menu] screen (Upload button)

Fig.103 [Main Menu] screen (Upload menu)

Fig.104 [Data Input Main] screen (Upload button)

Fig.105 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.106 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.107 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.108 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.109 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to.
When setting file data is specified, the system is automatically selected depending on the settings.

Fig.110 [Upload Settings] screen (Target System)

Specifying an IP Address
Specify the IP address of the destination system.
When setting file data is specified, the address automatically appears.

Fig.111 [Upload Settings] screen (IP Address)
64-EN– 64 –



65-EN

Setting File Creation Software for North America Operating Instructions
The following table shows the items in the File List:

Starting the Upload
After the preparation (P59 to P62) has been completed, click the Upload button. The upload starts.

Fig.112 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.113 Progress bar

CAUTION

Item Content
File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

If Smart BMS Manager is shut down during upload, stored data may be damaged and the controller may not operate.
Do not shut down the controller during upload.

Click button
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System settings

System Tab
The following table shows the settings configured on the System tab:

Smart BMS Manager

CAUTION

Item Content Data type / range
Building name Building name Characters (Up to 20 bytes, Forbidden: > < ” & \n ; ,)

Built-in controller fire alarm 
channel

Built-in controller fire alarm 
channel is used 

(Smart BMS Manager only)
0: N/A
1: Valid

Indoor unit total Q'ty Number of indoor units 1 - 128

Daily report closing time Time when the daily report 
is output 0:00 – 23:59

Monthly report closing date Date when the monthly 
report is output 1 - 31

Lock Linkage Mode Lock linkage mode pattern 

0: Setting No.0
1: Setting No.1
2: Setting No.2
3: Setting No.3

Energy Monitoring Whether the energy 
monitoring is used 

0: void
1: Valid (Distribution by capacity demand)

Stand-by power counting
Select the distribution 
mode of outdoor heater 
capacity 

1: Proportional sharing on indoor unit horse power codes.
2: Equal sharing on indoor units Q'ty
3: Distribution of power consumption except compressor 

warmer to tenants.

Words in error code definition file 
and zone name tags
(Smart BMS Manager only)

Language of error codes 
and zone name tags 

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano
8: Korean

Date display format (Smart BMS 
Manager only)

Display format of year / 
month / day 

1: yyyy/mm/dd
2: dd/mm/yyyy
3: mm/dd/yyyy
4: yyyy.mm.dd
5: dd.mm.yyyy
6: mm.dd.yyyy
7: yyyy-mm-dd
8: dd-mm-yyyy
9: mm-dd-yyyy

Starting day of the week (Smart 
BMS Manager only) Starting day of the week 1: Sunday

2: Monday

Temperature display: Interval Unit of temperature interval 0: Unit 1°C.
1: Unit 0.5°C.

Temperature display: °C./°F. Celsius / Fahrenheit 0: °C.
1: °F.

CONTACT Info. Support information Characters (Up to 38 bytes per line)

Fire alarm function that described in this manual can not be used with UL-approved system (Model: BMS-
SM1281HTLUL).
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The following table shows the operations of Lock Linkage Mode:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Smart BMS Manager

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Smart BMS Manager

Setting Lock (OFF > ON) Unlock (ON > OFF)
0: Setting No.0 Stop No effect

1: Setting No.1 Stop Release “Run – Stop” switch prohibition

2: Setting No.2 Stop + Prohibit “Run – 
Stop” switch Release “Run – Stop” switch prohibition

3: Setting No.3 Stop Run

Item Content Data type / range
IP Address IP address of the Web server Numeric value

Subnet Mask Subnet mask of the Web server Numeric value

Default Gateway Gateway of the Web server Numeric value

Digital I/O Relay Interface Q'ty Number of digital I/O interfaces 0 - 4

Energy Monitoring Relay Interface Q'ty Number of energy monitoring interfaces 0 - 4

Item Content Data type / range
Energy Monitoring Relay Interface

Address Data Interface number 1 - 4

Digital I/O Relay Interface

Address Data Interface number 1 - 4
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Interface Setting Tab
The following table shows the settings configured on the Interface Setting tab:

Smart BMS Manager

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Smart BMS Manager

Item Content Data type / range
Energy Monitoring Relay Interface

I/O Function Select the I/O function 0: No setting
4: Power Meter Signal Input

Pulse constants (kWh / pulse) Set the pulse constants 0.1 – 99.9

Digital I/O Relay Interface

I/O Function (Smart BMS Manager only) Select the I/O function
0: No setting
2: Door Lock Input
5: Demand

Signal logic Select the signal logic 0: negative logic
1: positive logic

Item Content Data type / range
LINE No Select the line No. address 1 - 2

Line address Refrigerant line number 1 - 32

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor name Enter the line name Characters

Outdoor unit address Unit number

Power meter input name Select the input name for energy monitoring No setting
WHE-1-1_1 - WHE-1-4_8
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Zone Tab
The following table shows the settings configured on the Zone tab:

Smart BMS Manager

Indoor Tab
The following table shows the settings configured on the Indoor tab:

Smart BMS Manager

Item Content Data type / range

Name Zone name
Characters (Up to 20 bytes for Floor / Area, Up to 40 
bytes for Tenant, Up to 100 bytes for Monthly report 
tenant Forbidden: > < ” & \n ; ,)

Tally Classifications Select the tally classification

0: N/A
1: Common use area
2: Tenant
Monthly report tenant only

Monthly report tenant name Select the monthly report tenant 
name

None
Monthly report tenant name list
Tenant only

Item Content Data type / range
LINE No Select the line No. address 1 - 2

Line Address Refrigerant line number 1 - 32

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 – 128: Child

Indoor unit model name Select from indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 20 bytes, Forbidden: > < ” & \n ; ,)

Floor name Select the floor No setting
Floor name list

Tenant name Select the tenant No setting
Tenant name list

Area name Select the area No setting
Area name list

Door-lock input name Select the input name for lock 
linkage

No setting
DIO-1-1_IN-1 - DIO-1-4_IN-8

Power meter input name Select the input name for energy 
monitoring

No setting
WHE-1-1_1 - WHE-1-4_8

General purpose interface Energy 
Coefficient (kWh)

General purpose Interface energy 
coefficient Can be entered

Air Conditioner No. Air-conditioner number 1 - 128
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Demand Tab
The following table shows the settings configured on the Demand tab:

Smart BMS Manager

Set Tree Name Screen
The following table shows the settings configured on the Set Tree Name screen:

Smart BMS Manager

Item Content Data type / range
Indoor

Control Mode Indoor demand alarm setting

0: Stop
10: Thermo Off (No Delay Cancel)
11: Thermo Off (10-sec Delay)
12: Thermo Off (20-sec Delay)
13: Thermo Off (30-sec Delay)
14: Thermo Off (60-sec Delay)
20: FAN

Item Content Data type / range
Zone 1 name Zone name - Floor Characters (Up to 30 bytes, Forbidden: > < ” & \n ; ,)

Zone 2 name Zone name - Tenant Characters (Up to 30 bytes, Forbidden: > < ” & \n ; ,)

Zone 3 name Zone name - Area Characters (Up to 30 bytes, Forbidden: > < ” & \n ; ,)
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7 Initialization tool

Initialization tool
The Initialization Tool resets the air-conditioner setting file data stored on the Smart BMS Manager, such as the 
schedule data, alarm history data, and daily / monthly report data, to the factory default.
The tool contains the Restore function, which restores using data backed up with Data Download Software or 
backed up during initialization.

CAUTION

Starting / exiting the initialization tool

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for North America or Windows menu to start the Initialization 
Tool.

Menu of the Setting File Creation Software for North America

Fig.114 [Main Menu] screen (Initialization Tool)

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America] > [Initialization Tool].

Perform “System Initialization” before restoring. Otherwise, the Monthly Report Creation Software may not work 
correctly.
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.115 [Main Menu] screen (Close button / Exit button)

Fig.116 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.117 Exit confirmation dialog box
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Initializing data in a target system
Stored daily / monthly report files are deleted from the target system if a setting file is initialized or specific data 
(Report data files) is deleted.
Before performing this function, save registered power distribution data with Data Download Software.

Initializing a Setting File
When a setting file is initialized, the schedule data, alarm history, and daily / monthly report files will be deleted in 
addition to the setting file.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Select [Initialize Setting Files].

4 Specify a backup folder. (Fig.119)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

5 Use the PING command to check the connection to the target system.

Fig.118 [Initialization Tool] screen
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Fig.119 [Browse For Folder] screen

6 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.120 [Initialization Tool] screen (Execute button / Execute menu)

7 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.121 [Warning] screen

8 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.122 Progress bar
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9 If the initialization is completed successfully, the completion dialog box appears.

10 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.123 Completion dialog box

Deleting Specific Data
Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Select [Delete specific Data].

4 Select data to delete.
[Schedule], [Alarm History], and [Report data files] can be selected. All the schedules of
execution, master, and charges will be deleted.

5 Specify a backup folder. (Fig.125)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.
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6 Use the PING command to check the connection to the target system.

Fig.124 [Initialization Tool] screen

Fig.125 [Browse For Folder] screen
76-EN– 76 –



77-EN

Setting File Creation Software for North America Operating Instructions
7 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.126 [Initialization Tool] screen (Execute button / Execute menu)

8 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.127 [Warning] screen

9 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.128 Progress bar

10 If the initialization is completed successfully, the completion dialog box appears.

11 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.129 Completion dialog box
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Initializing a system
You can reset a target system to its default settings. All data in the system will be deleted.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Specify a backup folder. (Fig.131)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.130 [Initialization Tool] screen

Fig.131 [Browse For Folder] screen
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5 Select the [Tool] menu then [System Initialization].

Fig.132 [Initialization Tool] screen (System Initialization menu)

6 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.133 [Warning] screen

7 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.134 Progress bar

8 If the initialization is completed successfully, the completion dialog box appears.

9 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.135 Completion dialog box
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Restoring data
You can restore data in a target system from backup using data automatically backed up with Initialization Tool or 
Data Download Software.
Note that all current data in the system will be deleted.
Perform “System Initialization” before restoring. Otherwise, the Monthly Report Creation Software may not work 
correctly.

Follow the procedure below:

1 Specify an IP address.

2 Select the target system.

3 Specify a backup folder. (Fig.137)
A backup folder can be specified before restoring data. If you do not specify a backup folder, the data will be 
backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier Corporation\Initialization 
Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier Corporation\Initialization Tool\backup” in 
Windows Vista/7. This folder is a hidden folder. To show the folder, you need to change the “Folder Options” 
settings.

4 Use the PING command to check the connection to the target system.

Fig.136 [Initialization Tool] screen

Fig.137 [Browse For Folder] screen
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5 Select the [Tool] menu then [Restore].

Fig.138 [Initialization Tool] screen (Restore menu)

6 The Check Destination Folder screen appears.

7 Click the Browse button, and select the folder containing the restored data on the displayed 
Browse For Folder screen (Fig.140).

8 Click the OK button.

Fig.139 [Check Destination Folder] screen

Fig.140 [Browse For Folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.141 [Warning] screen

10 Click the [OK] button.
The Restoration starts, and the progress bar appears.

Fig.142 Progress bar

11 If the restoration is completed successfully, the completion dialog box appears.

12 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned 
off, wait until over a minute passes before turning it back on.

Fig.143 Completion dialog box
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Checking the version information
Select the [Help] menu then [About].

Fig.144 [Initialization Tool] screen (About menu)

The version information appears.

Fig.145 [About] screen
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8 License agreement
Before using “Setting File Creation Software for North America” (hereinafter referred to as “this software,” read this
software's license agreement (hereinafter referred to as “this agreement”) carefully.
By using or installing this software in part or as a whole, you agree to be bound by the terms of this agreement.
If you (hereinafter referred to as “the user”) do not agree to the terms of this agreement, return it to the place of 
purchase without using or installing this software.

1. Under this agreement, this software means a computer program that is accompanied by this agreement as a 
recording medium or file, plus any and all other data including electronic documentation provided. Data that is 
explicitly not contained in this software is excluded.

2. Toshiba Carrier Corporation retains the ownership and intellectual property rights to this software. The user 
may use this software by agreeing to the terms and conditions of this agreement for purposes designated by 
Toshiba Carrier Corporation or agreed upon by Toshiba Carrier Corporation and the user.

3. Toshiba Carrier Corporation owns the copyright to this software. This software is protected by copyright laws 
and international treaties.

4. The user may duplicate and install this software for purposes described in the documentation for this software. 
The user shall immediately delete a copy of this software when it becomes unnecessary. Excluding the above 
case, the user shall not duplicate this software.

5. The user shall make no attempt to reverse engineer, decompile, disassemble, or alter this software.

6. The user shall not let any other users use this software over a local network or the Internet.

7. The user shall not distribute, give, rent, lease, sell, or sublicense this software or the right to use this software 
to any third party.

8. The user shall respect the intellectual property rights of this software. In addition, the user shall recognize that 
this software is confidential and avoid disclosing this software to any third party.

9. The user agrees to comply with the Foreign Exchange and Foreign Trade Control Law, the Export Trade 
Control Order, the United States Export Administration Act and all applicable international and national laws 
and regulations that apply to this software directly or indirectly.

10. The user is allowed to use this software as is without any explicit or implicit guarantee. No implicit commercial 
guarantees or specific purpose applicability guarantees apply. Toshiba Carrier Corporation has no 
responsibility to guarantee the quality or performance of this software. Toshiba Carrier Corporation has no 
responsibility whatsoever for any damage, loss, cost or expense, incurred by the user, arising from the use of 
this software.

11. If the terms of this agreement are violated or this agreement is cancelled, the user shall uninstall and remove 
this software, and return the recording media and files (including copies) to Toshiba Carrier Corporation.

12. Toshiba Carrier Corporation reserves the right to terminate the use of this software and modify or improve this 
software at any time.

13. This agreement will be governed by and construed in accordance with the laws of Japan. (However, the 
applicable law selection rules are excluded. Hereinafter the same shall apply)
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9 Creating a setting file using the import 
function

Workflow of creating a setting file using the import function
The following flowchart shows the process of creating a setting file using the import function:

* Configure the settings on the System tab, the pulse constant of Energy Monitoring Relay Interface Q'ty, etc. If 
other settings need to be changed, change them.

*

Start Setting File Creation Software

Output a template

Import

Set system data

Set server / interface

Set air conditioner information in the template

Set indoor unit, outdoor unit, zone and demand

Output DEF
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Outputting a template
Output a template (Excel file) in which you enter information on an air conditioner connected to a BMS model.
Select the [Tool] menu then [Output Template] on the Main Menu screen, and then select a BMS model.

Fig.146 [Main Menu] screen
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Select the destination folder and enter a file name to save the template. A message appears, and then the template 
is output.

Fig.147 [Save As] screen

Fig.148 Output completion dialog box

Fig.149 Example: Template for Smart BMS Manager
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Setting air conditioner information in the template
Set the air conditioner name, model name, address, zone, door lock channel, and energy monitoring relay interface 
channel. For the model name, refer to the model list output by selecting [Tool] > [Output Template] > [Model List] 
on the Main Menu screen.

Fig.150 Template setting example (Smart BMS Manager)

Fig.151 [Model List]
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Importing
Apply air conditioner information in the Excel file to the Setting File Creation Software by selecting and importing 
a file containing the air conditioner information as a template.
Select the [Tool] menu then [Import] on the Main Menu screen, and then select a BMS model.

Fig.152 [Main Menu] screen
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Select an Excel file to import. The import starts.

Fig.153 [Open] screen

The import starts, and the progress bar appears.

Fig.154 Progress bar

An error occurs if the Excel file to import is opened. Close the Excel file.

Fig.155 Error message box
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An error occurs if the Excel file to import contains an error. The cause and line No. are displayed. Check the Excel 
file. (Example: The model name does not exist, the indoor unit No. is duplicate)

Fig.156 Error message (Example: The indoor unit No. is duplicate)

When the import is complete, the Data Input Main screen appears. Configure the settings on the System tab, the 
pulse constant of Energy Monitoring Relay Interface Q’ty, etc. If other settings need to be changed, change them.

Fig.157 [Data Input Main] screen (System tab)
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.158 [Output File] button

Fig.159 [Output DEF File] menu
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Appendix A

Applying the monthly report tenant name to the tenant name
Select a tenant on the zone setup screen, and click the [Automatic setting of Tenant Name] button or select the 
[Operation] menu then [Automatic setting of Tenant Name]. The name of the monthly report tenant will be 
registered to the tenant. Note that the [Automatic setting of Tenant Name] button and menu are only available if 
the tenant name has not been registered.
* The number of characters for the tenant name is limited and the name may not be automatically set depending 

on the system.

Fig.160 [Zone] screen ([Automatic setting of Tenant Name] button)

Fig.161 [Zone] screen ([Automatic setting of Tenant Name] menu)

Fig.162 [Zone] screen (Monthly report tenant name applied to tenant)

Click button
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Copying a cell of an indoor unit
Follow the procedure below:
(1) Select a source cell, and press Ctrl + C.

Fig.163 [Indoor] screen (Source cell selected)

(2) Select a target cell.

Fig.164 [Indoor] screen (Target cell selected)

(3) Press Ctrl + V to paste the data.

Fig.165 [Indoor] screen (Result)
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To copy data to subsequent cells, follow the procedure below:
(1) Select a source cell.

Fig.166 [Indoor] screen (Source cell selected)

(2) Click and hold the lower right corner of the cell (the cursor changes to a “+” shape), and drag it over the target 
cells.

Fig.167 [Indoor] screen (Target cell selected)

(3) Release the mouse button.

Fig.168 [Indoor] screen (Result)
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Appendix B BACnet (BMS-STBN09UL, BMS-
STBN10UL)

CAUTION

Using the Setting File Creation Software for North America

Starting / Exiting the Setting File Creation Software for North America
Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1 Start the Setting File Creation Software for North America.
• Desktop icon
Double-click the desktop icon.

Fig.169 Setting File Creation Software for North America desktop icon

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

The air conditioner number is used as the identifier (address) for the air conditioner on the system when it is connected 
to the system.
This number is automatically indexed when a file is output, if an indoor unit is added, deleted, or moved on the indoor 
tab, the air conditioner number before the change may be different after the change.
Because of this, if the operation above is done, the air conditioner number is changed and the address may be incorrect 
when reconnecting to the system (The air conditioner may not operate or a different air conditioner may operate).
If you change the settings on the indoor tab, it may change the air conditioner number used on the system, therefore 
note that it may be necessary to reset the system when outputting the file and uploading to the BACnet local server.
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2 The startup screen appears.
The startup screen appears.

Fig.170 Startup screen

3 Setting File Creation Software for North America Startup Complete.
The startup screen (Fig.170) disappears, and the Main Menu screen (Fig.1) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.171 [Main Menu] screen (Close button)

Fig.172 [Main Menu] screen (Exit button)

Fig.173 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.174 Exit confirmation dialog box

Click button

Click button
98-EN– 98 –



99-EN

Setting File Creation Software for North America Operating Instructions
Creating New Data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.2) appears.

Fig.175 [Main Menu] screen (New button 1)

Fig.176 [Main Menu] screen (New button 2)

Fig.177 [Main Menu] screen (New menu)

When the Open screen has opened, select a file to edit. The system screen (Fig.3) appears.

Fig.178 [Open] screen

Click button

Click button
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Using a History File to Edit Data
Double-click a line in the History List, or select a file from Recently Used File. The system screen (Fig.3) appears.

Fig.179 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.180 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.181 Warning message box
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Setting Up the System
Select the [System] tab and configure the settings.

Fig.182 [System] tab

The following table shows how to enter / select data:

(*) BMS-STBN10UL only

Item Data type Selection Note
Building name Entered by user

Indoor unit total Q'ty Entered by user Numeric value only Up to 128

Temperature display: Interval Selected by user
(BMS-STBN08E cannot be edited) Select from list

Temperature display: C./F. Selected by user
(BMS-STBN08E cannot be edited) Select from list

Event Priority (*) Entered by user Numeric value only 0 - 255

BACnet System with Smart BMS 
Manager Series Selected by user Select from list

Receive UDP Port (*) Entered by user Numeric value only 47808 - 47823
49152 - 65535

Transmit UDP Port (*) Entered by user Numeric value only 47808 - 47823
49152 - 65535

Device instance Number additional 
value (*) Selected by user Select from list

Instance Number Setting (*) Entered by user Numeric value only 0 - 4194303

Table.8 How to enter / select data
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Setting Up the Server
Select "Server Setting" on the "Server / Interface" tab and set the number of interfaces and the IP address of the 
BACnet local server.
On the BACnet, when the server's IP address is uploaded it is automatically edited according to the IP address, 
subnet mask, and default gateway information set in this tab.

Fig.183 [Server Setting] tab

The following table shows how to enter / select data:

Item Data type Selection Note
IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

TCS-net Relay Interface Q'ty Entered by user Numeric value only 1 - 8

Table.9 How to enter / select data
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Setting Up the Interface Address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.184 [Interface Address] tab

The following table shows how to enter / select data:

Item Data type Selection Note
TCS-Net Relay Interface Address 
Data Entered by user Numeric value only 1 - 8

Table.10 How to enter / select data
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Adding an Outdoor Unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor 
unit list.

Fig.185 [Outdoor] tab (New button)

Fig.186 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Item Data type Selection Note
IF No Selected by user Select from list

Line address Entered by user Numeric value only

Outdoor unit combination model name Selected by user Select from the Select 
outdoor unit model screen

Outdoor unit model name Cannot be edited Select from the Select 
outdoor unit model screen

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Table.11 How to enter / select data

Click button
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Selecting an Outdoor Unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.5) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. “Outdoor unit combination model name”, “Outdoor unit model name,” and “Outdoor unit address” will 
automatically become available on the [Outdoor] tab (Fig.5). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.187 [Select outdoor unit model] screen
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Copying the Data of an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address” will automatically be increased in one.

Fig.188 [Outdoor] tab (Copy button)

Fig.189 [Outdoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Outdoor Units
Select a line of outdoor unit on the [Outdoor] tab (Fig.5), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.190 [Outdoor] tab (Multicopy button)

Fig.191 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” will automatically be increased in one.

Fig.192 [Copy line count] screen

Click button
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Deleting the Data of Outdoor Units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.5), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.193 [Outdoor] tab (Delete button)

Fig.194 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.195 Deletion confirmation dialog box

Click button
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Inserting an Outdoor Unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.196 [Outdoor] tab (Insert button)

Fig.197 [Outdoor] tab (Insert menu)

Click button
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Adding an Indoor Unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.198 [Indoor] tab (New button)

Fig.199 [Indoor] tab (New menu)

The following table shows how to enter / select data:

Item Data type Selection Note
IF No Selected by user Select from list

Line address Entered by user Numeric value only

Indoor unit address Entered by user Numeric value only

Parent Indoor Unit No. Entered by user Numeric value only

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Air Conditioner No. Cannot be edited

Table.12 How to enter / select data

Click button
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Selecting an indoor unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.7) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. “Indoor unit 
model name” will automatically become available on the [Indoor] tab (Fig.7). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.200 [Select indoor unit model] screen
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Copying the Data of an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.201 [Indoor] tab (Copy button)

Fig.202 [Indoor] tab (Copy menu)

Click button
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Copying the Data of Multiple Indoor Units
Select a line of indoor unit on the [Indoor] tab (Fig.7), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.203 [Indoor] tab (Multicopy button)

Fig.204 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.205 [Copy line count] screen

Click button
114-EN– 114 –



115-EN

Setting File Creation Software for North America Operating Instructions
Deleting the Indoor Units
Select one or more lines of indoor units on the [Indoor] tab (Fig.7), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.206 [Indoor] tab (Delete button)

Fig.207 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.208 Deletion confirmation dialog box

Click button
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Inserting an Indoor Unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.209 [Indoor] tab (Insert button)

Fig.210 [Indoor] tab (Insert menu)

Click button
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Changing the Order of the Indoor Units
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Up] / [Down] button, or select the [Operation] 
menu > [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.211 [Indoor Unit] tab (Up button)

Fig.212 [Indoor Unit] tab (Down button)

Fig.213 [Indoor Unit] tab (Up menu)

Fig.214 [Indoor Unit] tab (Down menu)

Click button

Click button
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Adding an RegisterForeignDevice (BMS-STBN10UL only)
Select the in [RegisterForeignDevice] tab in [Control Setting (Communication)] tab, and click [Add] button.
After a click, a line is added to the list. Configure the settings for BBMD (BACnet/IP Broadcast Management 
Device). A maximum of 10 lines can be registered.

Fig.215 [RegisterForeignDevice] tab

The following table shows how to enter / select data:

Item  Data type Selection Note
IP address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Port Number Entered by user Numeric value only

Transmission Interval (second) Entered by user Numeric value only 60~65535

Click button
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Deleting the Data of RegisterForeignDevice
Select one or more lines of Foreign BACnet Device, click the [Delete] button.

Fig.215-1 [RegisterForeignDevice] tab ([Delete] button)

The deletion confirmation dialog box appears.
Click the OK button to delete. The line will be deleted from the list. To cancel deletion, click the Cancel button.

Fig.215-2 Deletion confirmation dialog box

Click button
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Setting an Object (BMS-STBN10UL only)
Select the in [Object] tab in [Control Setting (Communication)] tab, configure the Event Transmit, COV ON/OFF, 
Event State, Status Flags, Limit Enable and Event Priority settings for each Object.

Fig.216 [Object] tab

The following table shows how to enter / select data:

Item Data type Selection Note
Event Transmit Selected by user Select from checkbox

COV ON/OFF Selected by user Select from list

Event State Selected by user Select from checkbox

Status Flags Selected by user Select from checkbox

Limit Enable Selected by user Select from checkbox

Event Priority Entered by user 0 - 255
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Saving Created Data to a File
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.217 [Save] button

Fig.217-1 [Save Setting File] menu

Fig.217-2 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.218 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button 
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.219 Overwrite confirmation dialog box
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Outputting Files
The air conditioner number is used as the identifier (address) for the air conditioner on the system when it is 
connected to the system.
This number is automatically indexed when a file is output, if an indoor unit is added, deleted, or moved on the 
indoor tab, the air conditioner number before the change may be different after the change.
Because of this, if the operation above is done, the air conditioner number is changed and the address may be 
incorrect when reconnecting to the system (The air conditioner may not operate or a different air conditioner may 
operate).
If you change the settings on the indoor tab, it may change the air conditioner number used on the system, 
therefore note that it may be necessary to reset the system when outputting the file and uploading to the BACnet 
local server.

Fig.220 Indoor screen

Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.221 [Output File] button

Click button
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Fig.222 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to Overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.223 Overwrite confirmation dialog box

The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.224 [Browse For Folder] screen
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The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.225 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and 
click the OK button. The upload screen appears.

Fig.226 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.227 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.228 Deletion confirmation dialog box
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Uploading a setting file (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.1) or [Data Input 
Main] screen (Fig.3). The Upload Settings screen (Fig.13) appears.

Fig.229 [Main Menu] screen (Upload button)

Fig.230 [Main Menu] screen (Upload menu)

Fig.231 [Data Input Main] screen (Upload button)

Fig.232 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.233 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.234 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.235 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.236 [Browse For Folder] screen

Click button
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Specifying a Target System (type and model name)
Select a destination system to upload the file to.
When Setting File Data is specified, the target system is automatically set to “BACnet” & “BMS-STBNxxx”.

Fig.237 [Upload Settings] screen (Type, Model Name)

Regarding the IP address (Factory setting of Port1 IP address: 192.168.1.100)
If the target system is BACnet, uploading to the server can only be done from Port2 of the BACnet server. The IP 
address of Port2 is fixed as 192.168.0.99, the IP address of Port2 cannot be changed. Also, before uploading it is 
necessary to change the IP address to 192.168.0.98 and the subnet mask to 255.255.255.0 for the PC that is using 
this software. If the change is not done, the upload is not possible.

Fig.238 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (Specifying Setting File Data) has been completed, click the Upload button. The upload starts.

Fig.239 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.240 Progress bar

CAUTION

Item Content
File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

If BACnet server is shut down during upload, stored data may be damaged and the server may not operate.
Do not shut down the server during upload.

Click button
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System settings

System Tab
The following table shows the settings configured on the System tab:

(*) BMS-STBN10UL only

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Item Content Data type / range

Building name Building name Characters (Up to 100 bytes,
Forbidden: “ ' > < : ; , # &)

Indoor unit total Q'ty Number of indoor units 1 - 128

Temperature display: Interval Unit of temperature interval 0: Unit 1 °C.
1: Unit 0.5 °C.

Temperature display: C./F. Celsius 0: °C.
1: °F.

Event Priority (*) Setting Event Priority of the server 0 - 255

BACnet System with Smart BMS Manager 
Series

Concomitant use
Smart BMS Manager void/valid

0: Void
1: Valid

Receive UDP Port (*) Receive UDP Port number 47808 - 47823, 49152 - 65535

Transmit UDP Port (*) Transmit UDP Port number 47808 - 47823, 49152 - 65535

Device instance Number additional value (*)

0: Use 1 byte of Last byte of IP address 
number

1: Use 2 byte of 3 and 4 byte of IP 
address number

2: User setting

Instance Number Setting (*) Instance number 0 - 4194303

Item Content Data type / range
IP Address IP address of the server Numeric value

Subnet Mask Subnet mask of the server Numeric value

Default Gateway Gateway of the server Numeric value

TCS-net Relay Interface Q'ty. Number of TCS-net relay 
interfaces 1 - 8

Item Content Data type / range
TCS-net relay Interface

Address Data Interface number 1 - 8

Item Content Data type / range

IF No Select the TCS-net Relay 
Interface address 1 - 8

Line address Refrigerant line number 1 - 28

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models
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Indoor Tab
The following table shows the settings configured on the Indoor tab:

Control Setting(Communication)

RegisterForeignDevice
The following table shows the settings configured on the RegisterForeignDevice tab:

Object

Outdoor name Enter the line name Characters (Up to 100 bytes,
Forbidden: “ ' > < : ; , # &)

Outdoor unit address Unit number

Item Content Data type / range

IF No Select the TCS-net Relay 
Interface address 1 - 8

Line address Refrigerant line number 1 - 31

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 - 128: Child

Indoor unit model name Select the indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 100 bytes,
Forbidden: “ ' > < : ; , # &)

Air Conditioner No. Air-conditioner number 1 - 128

Item Content Data type / range

IP address IP address of the Foreign 
Device(BBMD) Numeric value

Subnet Mask SubnetMask of the Foreign 
Device(BBMD) Numeric value

Port Number Port Number of the Foreign 
Device(BBMD) Numeric value

Transmission Interval (second) Transmission Interval time 
for the Foreign Device(BBMD) 60 - 65535

Item Content Data type / range

Event Transmit Event Transmit setting
NORMAL
OFFNORMAL
FAULT

COV ON/OFF COV ON/OFF setting ON
OFF

Event State Event State setting
NORMAL
OFFNORMAL
FAULT

StatusFlags
Status bit IN_ALARM ON/OFF 
setting
Status bit FAULT ON/OFF setting

IN_ALARM
FAULT

Limit Enable low Limit Enable ON/OFF setting
high Limit Enable ON/OFF setting

low Limit Enable
high Limit Enable

Event Priority Event Priority setting 0 - 255

Item Content Data type / range
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Initialization tool
There is an initialization function to return the system to the factory settings, a function to download setting 
information from the BACnet local server, and a function to update versions of the BACnet local server software.

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for North America or Windows menu to start the Initialization 
Tool.
Menu of the Setting File Creation Software for North America

Fig.241 [Main Menu] screen (Initialization Tool)

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America] > [Initialization Tool].
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.242 [Main Menu] screen (Close button / Exit button)

Fig.243 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.244 Exit confirmation dialog box

Click button
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Initializing a system
You can reset a target system to its default settings. All data in the system will be deleted.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a backup folder. (Fig.246)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.245 [Initialization Tool] screen

Fig.246 [Browse For Folder] screen
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5 Select the [Tool] menu then [System Initialization].

Fig.247 [Initialization Tool] screen (System Initialization menu)

6 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.248 [Warning] screen

7 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.249 Progress bar

8 If the initialization is completed successfully, the completion dialog box appears.

9 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned off, wait until 
over a minute passes before turning it back on.

Fig.250 Completion dialog box
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Downloading data
You can download setting data from the BACnet local server.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a folder in which to download. (Fig.252)
Specify a folder in which to save the files downloaded from the BACnet local server. If you do not specify a 
folder, files are saved to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup", in Windows XP or to "C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup", in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the "Folder Options" settings.

4 Use the PING command to check the connection to the target system.

Fig.251 [Initialization Tool] screen

Fig.252 [Browse For Folder] screen
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5 Select the [Tool] menu then [Download].

Fig.253 [Initialization Tool] screen (Download menu)

6 The download starts and the progress bar appears.

Fig.254 Progress bar

7 If the download is completed successfully, the completion dialog box appears.

Fig.255 Completion dialog box
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Upgrading
This function upgrades the software of the BACnet local server.

Upgrade data
Upgrade data's file name is fixed “versionup.zip”. Don't change upgrade data's file name.

NOTE

Perform the following procedure to upgrade:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a backup folder. (Fig.256)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.256 [Initialization Tool] screen

An upgraded function cannot be downgraded. The upgrade is performed by connecting the target device to a computer 
containing this software via a network. If the network is disconnected or the power is turned off during the upgrade, the 
system may malfunction.
140-EN– 140 –



141-EN

Setting File Creation Software for North America Operating Instructions
Fig.257 [Browse For Folder] screen

5 Select the [Tool] menu then [Upgrade].

Fig.258 [Initialization Tool] screen (Upgrade menu)

6 The Check Upgrade folder screen appears.

7 Click the [Browse] button, and select the folder containing the Upgrade data on the displayed 
Browse For Folder screen (Fig.259).

8 Click the [OK] button.

Fig.259 [Check Upgrade folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.260 [Warning] screen

10 Click the [OK] button.
The Upgrade starts, and the progress bar appears.

Fig.261 Progress bar

11 If the upgrade is completed successfully, the completion dialog box appears.
The version of the upgraded software appears.

Fig.262 Completion dialog box
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Appendix C Touch Screen Controller (BMS-
CT5120UL)

Starting / exiting the Setting File Creation Software for North 
America

Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1. Start the Setting File Creation Software for North America.

• Desktop icon
Double-click the desktop icon.

Fig.263 Setting File Creation Software for North America desktop icon

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

2. The startup screen appears.
The startup screen appears.

Fig.264 Startup screen

3. Setting File Creation Software for North America Startup Complete
The startup screen (Fig.264) disappears, and the Main Menu screen (Fig.1) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.265 [Main Menu] screen (Close button)

Fig.266 [Main Menu] screen (Exit button)

Fig.267 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.268 Exit confirmation dialog box

Click button

Click button
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Creating new data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.2) appears.

Fig.269 [Main Menu] screen (New button 1)

Fig.270 [Main Menu] screen (New button 2)

Fig.271 [Main Menu] screen (New menu)

Click button

Click button
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Selecting a file to edit data
Click the [Select File] button, or select the [File] menu then [Open]. The Open screen appears.

Fig.272 [Main Menu] screen (Select File button)

Fig.273 [Main Menu] screen (Open button)

Fig.274 [Main Menu] screen (Open menu)

Click button

Click button
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When the Open screen has opened, select a file to edit. The System screen (Fig.3) appears.

Fig.275 [Open] screen
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Using a history file to edit data
Double-click a line in the History List, or select a file from Recently Used File. The System screen (Fig.3) appears.

Fig.276 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.277 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.278 Warning message box
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Setting up the system
Select the [System] tab and configure the settings.

Fig.279 [System] tab

The following table shows how to enter / select data:
Item Data type Selection Note

Building name Entered by user –
Indoor unit total Q'ty Entered by user Numeric value only
Daily report closing time Entered by user Time only
Monthly report closing date Entered by user Numeric value only
Lock Linkage Mode Selected by user Select from list
Date display format Selected by user Select from list
Starting day of the week Selected by user Select from list
Energy Monitoring Selected by user Select from list
Stand-by power counting Selected by user Select from list
Filter sign display mode Selected by user Select from list
Back light save count (minutes) Entered by user Numeric value only
Select Touch Screen Display Language Selected by user Select from list
Words in error code definition file Selected by user Select from list
Temperature display: Interval Selected by user Select from list
Temperature display: C./F. Selected by user Select from list
Summer time shift (minutes) Entered by user Numeric value only
Flap  Setting (group control) Selected by user Select from list
Memory refresh Selected by user Select from list
CONTACT Info. Entered by user –

Table.13 How to enter / select data
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Setting up the server
Select the [Server Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.280 [Server Setting] tab

The following table shows how to enter / select data:

Item Data type Selection Note
IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

TCS-Net Relay Interface Q'ty Entered by user Numeric value only 1 - 12

Digital I/O Relay Interface Q'ty Entered by user Numeric value only 0 - 8

Energy Monitoring Relay 
Interface Q'ty Entered by user Numeric value only 0 - 8

Table.14 How to enter / select data
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Setting up the interface address
Select the [Interface Address] tab under the [Server / Interface] tab, and configure the settings.

Fig.281 [Interface Address] tab

The following table shows how to enter / select data:

Item Data type Selection Note
TCS-Net Relay Interface Address 
Data Entered by user Numeric value only

Energy Monitoring Relay 
Interface Address Data Entered by user Numeric value only

Digital I/O Relay Interface 
Address Data Entered by user Numeric value only

Table.15 How to enter / select data
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Setting up the interface function
Select the [Interface Setting] tab under the [Server / Interface] tab, and configure the settings.

Fig.282 [Interface Setting] tab

The following table shows how to enter / select data:

Item Data type Selection Note
I/O Function Selected by user Select from list

Signal logic Selected by user Select from list Digital I/O Interface Only

Pulse constants Entered by user Numeric value only
0.1 – 99.9, Energy
Monitoring Relay Interface 
Only

Table.16 How to enter / select data
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Adding an outdoor unit
Click the [New] button, or select the [Operation] menu > [Outdoor Unit] > [New]. A line will be added to the outdoor
unit list.

Fig.283 [Outdoor] tab (New button)

Fig.284 [Outdoor] tab (New menu)

The following table shows how to enter / select data:

Item Data type Selection Note
LINE No / I/F No Selected by user Select from list

Line address Entered by user Numeric value only

Outdoor unit combination model 
name Selected by user Select from the Select 

outdoor unit model screen

Outdoor unit model name Cannot be edited

Outdoor name Entered by user

Outdoor unit address Cannot be edited

Power meter input name Selected by user Select from list

Table.17 How to enter / select data

Click button
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Selecting an outdoor unit
Clicking a cell of an outdoor unit combination model name on the [Outdoor] tab (Fig.5) displays the Select outdoor 
unit model screen. On the screen, double-click a cell of an outdoor unit model, or select a model then click the OK 
button. “Outdoor unit combination model name,” “Outdoor unit model name,” and “Outdoor unit address” will 
automatically become available on the [Outdoor] tab (Fig.5). To cancel changing the outdoor unit setting, click the 
Cancel button to return to the [Outdoor] tab.

Fig.285 [Select outdoor unit model] screen
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Copying the data of an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Copy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Copy]. The copied outdoor unit will be added to the outdoor unit list. The numbers of the 
copied “Line address” and “Outdoor name” will automatically be increased in one.

Fig.286 [Outdoor] tab (Copy button)

Fig.287 [Outdoor] tab (Copy menu)

Click button
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Copying the data of multiple outdoor units
Select a line of outdoor unit on the [Outdoor] tab (Fig.5), and click the [Multicopy] button, or select the [Operation] 
menu > [Outdoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.288 [Outdoor] tab (Multicopy button)

Fig.289 [Outdoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied outdoor units will be added to the outdoor unit list. The 
numbers of the copied “Line address” and “Outdoor name” will automatically be increased in one.

Fig.290 [Copy line count] screen

Click button
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Deleting the data of outdoor units
Select one or more lines of outdoor units on the [Outdoor] tab (Fig.5), and click the [Delete] button, or select the 
[Operation] menu > [Outdoor Unit] > [Delete].

Fig.291 [Outdoor] tab (Delete button)

Fig.292 [Outdoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The outdoor units will be deleted from the outdoor unit list. To cancel deletion, click 
the Cancel button.

Fig.293 Deletion confirmation dialog box

Click button
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Inserting an outdoor unit
Select a line of an outdoor unit on the [Outdoor] tab (Fig.5), and click the [Insert] button, or select the [Operation] 
menu > [Outdoor Unit] > [Insert]. A line will be inserted at the selected location in the outdoor unit list.

Fig.294 [Outdoor] tab (Insert button)

Fig.295 [Outdoor] tab (Insert menu)

Click button
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Editing a zone
On the [Zone] tab, select a section (Floor, Monthly report tenant, Tenant, Area) from the combo box in the upper 
left corner of the window. Enter a name in the displayed zone list.

Fig.296 [Zone] tab (Floor)

Fig.297 [Zone] tab (Monthly report tenant)

Click
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Fig.298 [Zone] tab (Tenant)

Fig.299 [Zone] tab (Area)
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Adding a zone
Click the [New] button, or select the [Operation] menu > [Tree] > [New]. A line will be added to the zone list.

Fig.300 [Zone] tab (New button)

Fig.301 [Zone] tab (New button)

The following table shows how to enter / select data:

Item Data type Selection Note
Name Entered by user

Tally Classifications Selected by user Select from list Monthly report tenant only

Monthly report tenant name Selected by user Select from list Tenant only

Table.18 How to enter / select data

Click button
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Copying the data of a zone
Select a line of a zone on the [Zone] tab, and click the [Copy] button, or select the [Operation] menu > [Tree] > 
[Copy]. The copied zone will be added to the zone list. The number of the copied “Name” will automatically be 
increased in one.

Fig.302 [Zone] tab (Copy button)

Fig.303 [Zone] tab (Copy menu)

Click button
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Copying the data of multiple zones
Select a line of zone on the [Zone] tab, and click the [Multicopy] button, or select the [Operation] menu > [Tree] > 
[Multicopy]. The Copy line count screen appears.

Fig.304 [Zone] tab (Multicopy button)

Fig.305 [Zone] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied zones will be added to the zone list. The number of the 
copied “Name” will automatically be increased in one.

Fig.306 [Copy line count] screen

Click button
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Deleting the data of zones
Select one or more lines of zones on the [Zone] tab (Fig.6), and click the [Delete] button, or select the [Operation] 
menu > [Tree] > [Delete].

Fig.307 [Zone] tab (Delete button)

Fig.308 [Zone] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The zones will be deleted from the zone list. To cancel deletion, click the Cancel 
button.

Fig.309 Deletion confirmation dialog box

Note that the following data will also be deleted if a zone is deleted:
• The Zone setting of an indoor unit set to the deleted zone

Click button
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Inserting a zone
Select a line of a zone on the [Zone] tab (Fig.6), and click the [Insert] button, or select the [Operation] menu > [Tree] 
> [Insert]. A line will be inserted at the selected location in the zone list.

Fig.310 [Zone] tab (Insert button)

Fig.311 [Zone] tab (Insert menu)

Click button
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Renumbering the zones
Click the [Renumber] button, or select the [Operation] menu > [Tree] > [Renumber]. The numbers in the “No” 
column will be reassigned.

Fig.312 [Zone] tab (Renumber button)

Fig.313 [Zone] tab (Renumber menu)

Click button
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Changing the order of the zones
Select a line of a zone on the [Zone] tab, and click the [Up] / [Down] button, or select the [Operation] menu > [Tree] 
> [Up] / [Down]. The selected line moves up or down.

Fig.314 [Zone] tab (Up button)

Fig.314-1 [Zone] tab (Down button)

Fig.315 [Zone] tab (Up menu)

Fig.315-1 [Zone] tab (Down menu)

Click button

Click button
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Adding an indoor unit
Click the [New] button, or select the [Operation] menu > [Indoor Unit] > [New]. A line will be added to the indoor 
unit list.

Fig.316 [Indoor] tab (New button)

Fig.317 [Indoor] tab (New menu)

Click button
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The following table shows how to enter / select data:

Item Data type Selection Note
LINE No / I/F No Selected by user Select from list

Line Address Entered by user

Indoor unit address Entered by user

Parent Indoor Unit No. Entered by user

Indoor unit model name Selected by user Select from the Select 
indoor unit model screen

R.C.group / indoor name Entered by user

Floor name Selected by user Select from list

Tenant name Selected by user Select from list

Area name Selected by user Select from list

Door-lock input name Selected by user Select from list

Power meter input name Selected by user Select from list

General purpose interface Energy 
Coefficient (kWh) Entered by user

Air Conditioner No. Entered by user

Table.19 How to enter / select data
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Selecting an Indoor Unit
Clicking a cell of an indoor unit model name on the [Indoor] tab (Fig.7) displays the Select indoor unit model screen. 
On the screen, double-click a cell of an indoor unit model, or select a model then click the OK button. “Indoor unit 
model name” will automatically become available on the [Indoor] tab (Fig.7). To cancel changing the indoor unit 
setting, click the Cancel button to return to the [Indoor] tab.

Fig.318 [Select indoor unit model] screen
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Copying the data of an indoor unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Copy] button, or select the [Operation] menu 
> [Indoor Unit] > [Copy]. The copied indoor unit will be added to the indoor unit list. The numbers of the copied 
“Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.319 [Indoor] tab (Copy button)

Fig.320 [Indoor] tab (Copy menu)

Click button
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Copying the data of multiple indoor units
Select a line of indoor unit on the [Indoor] tab (Fig.7), and click the [Multicopy] button, or select the [Operation] menu 
> [Indoor Unit] > [Multicopy]. The Copy line count screen appears.

Fig.321 [Indoor] tab (Multicopy button)

Fig.322 [Indoor] tab (Multicopy menu)

Enter the copy count, then click the OK button. The copied indoor units will be added to the indoor unit list. The 
numbers of the copied “Indoor unit address” and “R.C.group / indoor name” will automatically be increased in one.

Fig.323 [Copy line count] screen

Click button
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Deleting the indoor units
Select one or more lines of indoor units on the [Indoor] tab (Fig.7), and click the [Delete] button, or select the 
[Operation] menu > [Indoor Unit] > [Delete].

Fig.324 [Indoor] tab (Delete button)

Fig.325 [Indoor] tab (Delete menu)

The deletion confirmation dialog box appears.
Click the OK button to delete. The indoor units will be deleted from the indoor unit list. To cancel deletion, click the 
Cancel button.

Fig.326 Deletion confirmation dialog box

Click button
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Inserting an indoor unit
Select a line of an indoor unit on the [Indoor] tab (Fig.7), and click the [Insert] button, or select the [Operation] menu 
> [Indoor Unit] > [Insert]. A line will be inserted at the selected location in the indoor unit list.

Fig.327 [Indoor] tab (Insert button)

Fig.328 [Indoor] tab (Insert menu)

Click button
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Changing the order of the indoor units
Select a line of an indoor unit on the [Indoor] tab, and click the [Up] / [Down] button, or select the [Operation] menu 
> [Indoor Unit] > [Up] / [Down]. The selected line moves up or down.

Fig.329 [Indoor Unit] tab (Up button)

Fig.329-1 [Indoor Unit] tab (Down button)

Fig.330 [Indoor Unit] tab (Up menu)

Fig.330-1 [Indoor Unit] tab (Down menu)

Click button

Click button
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Deleting all air conditioner No. of the indoor units
Click the [Clear] button, or select the [Operation] menu > [Indoor Unit] > [Clear]. All the Air Conditioner No. will be 
deleted.

Fig.331 [Indoor Unit] tab (Clear button)

Fig.332 [Indoor Unit] tab (Clear menu)

Click button
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Setting up the demand alarm
Select the [Demand] tab, select a demand device, and set up the demand alarm.

Fig.333 [Demand] tab (Indoor)

Fig.334 [Demand] tab (Outdoor)
178-EN– 178 –



179-EN

Setting File Creation Software for North America Operating Instructions
Setting / canceling the indoor demand alarm input
The information of the indoor units appears in the Demand list. Select an control mode of the demand alarm from 
the combo box.

Fig.335 [Demand] tab (Control Mode selection)

Select one or more demand alarm input names.

Fig.336 [Demand] tab (Demand Alarm input name selection)
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Clicking the [Set] button sets the selected demand alarm names to the selected input mode.

Fig.337 [Demand] tab (Set)

Clicking the [Cancel] button sets the selected demand alarm names to “No setting”.

Fig.338 [Demand] tab (Cancel)

The selected control 
mode is set

“No setting” is set
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Setting / canceling the outdoor demand alarm input
The information of the outdoor units appears in the Demand list. Select an control mode of the demand alarm from 
the combo box.

Fig.339 [Demand] tab (Control Mode selection)

Select one or more demand alarm input names.

Fig.340 [Demand] tab (Demand Alarm input name selection)
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Clicking the [Set] button sets the selected demand alarm names to the selected input mode.

Fig.341 [Demand] tab (Set)

Clicking the [Cancel] button sets the selected demand alarm names to “No setting”.

Fig.342 [Demand] tab (Cancel)

The selected control 
mode is set

“No setting” is set
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Saving created data to a file
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.343 [Save] button

Fig.344 [Save Setting File] menu

Fig.345 [Save Setting File As] menu

Click button
– 183 –



EN

Setting File Creation Software for North America Operating Instructions
When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.346 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.347 Overwrite confirmation dialog box
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Outputting a DEF File
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.348 [Output File] button

Fig.349 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.350 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.351 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the
section containing the error.

Fig.352 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and
click the OK button. The upload screen appears.

Fig.353 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.354 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.355 Deletion confirmation dialog box

This history item is deleted 
if [Delete Selected History] 
is selected
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Uploading a setting file (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.1) or [Data Input 
Main] screen (Fig.3). The Upload Settings screen (Fig.13) appears.

Fig.356 [Main Menu] screen (Upload button)

Fig.357 [Main Menu] screen (Upload menu)

Fig.358 [Data Input Main] screen (Upload button)

Fig.359 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.360 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.361 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.362 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.363 [Browse For Folder] screen

Click button
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Specifying a Target System
Select a destination system to upload the file to.
When setting file data is specified, the system is automatically selected depending on the settings.

Fig.364 [Upload Settings] screen (Target System)

Specifying an IP Address
Specify the IP address of the destination system.
When setting file data is specified, the address automatically appears.

Fig.365 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (P60 to P63) has been completed, click the Upload button. The upload starts.

Fig.366 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.367 Progress bar

CAUTION

Item Content
File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

If Compliant Manager, Smart BMS Manager or Touch Screen Controller is shut down during upload, stored data may 
be damaged and the controller may not operate.
Do not shut down the controller during upload.

Click button
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System settings

System Tab
The following table shows the settings configured on the System tab:

Item Content Data type / range
Building name Building name Characters (Up to 100 bytes, Forbidden: ;  :  ,  #)
Indoor unit total Q'ty Number of indoor units 1 - 512

Daily report closing time Time when the daily report 
is output 0:00 – 23:59

Monthly report closing date Date when the monthly 
report is output 1 - 31

Lock Linkage Mode Lock linkage mode pattern 

0: Setting No.0
1: Setting No.1
2: Setting No.2
3: Setting No.3

Energy Monitoring Whether the energy 
monitoring is used 

0: void
1: Valid (Distribution by capacity demand)

Stand-by power counting
Select the distribution 
mode of outdoor heater 
capacity 

1: Proportional sharing on indoor unit horse power codes.
2: Equal sharing on indoor units Q'ty
3: Distribution of power consumption except compressor 

warmer to tenants.

Select Touch Screen Display 
Language Language of display

1: English
5: Espanol
6: Francais

Words in error code definition file Language of error codes 

1: English
2: Chinese (Simplified)
4: Deutsch
5: Espanol
6: Francais
7: Italiano
8: Korean
9: Portuguese
10: Dutch
11: Russian
12: Turkish
13: Greek
14: Czech
15: Croatian

Date display format Display format of year / 
month / day 

1: yyyy/mm/dd
2: dd/mm/yyyy
3: mm/dd/yyyy
4: yyyy.mm.dd
5: dd.mm.yyyy
6: mm.dd.yyyy
7: yyyy-mm-dd
8: dd-mm-yyyy
9: mm-dd-yyyy

Starting day of the week Starting day of the week 1: Sunday
2: Monday

Temperature display: Interval Unit of temperature interval 0: Unit 1°C.
1: Unit 0.5°C.

Temperature display: °C./°F. Celsius / Fahrenheit 0: °C.
1: °F.

CONTACT Info. Contact Information Characters (Up to 114 byte per line, Forbidden:   ; : , #)
Filter sign display mode Filter sign display mode 1: display
Back light save count (minutes) Back light off time 0 - 99

Summer time shift (minutes) Correction time for summer 
time 1 - 180
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The following table shows the operations of Lock Linkage Mode:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Interface Address Tab
The following table shows the settings configured on the Interface Address tab:

Flap  Setting (group control) Synchronism of parent and 
child unit's flap setting

0: Void
1: Valid

Memory refresh Regularly reboot for 
memory leak prevention

0: Void
1: Valid

Setting Lock (OFF > ON) Unlock (ON > OFF)
0: Setting No.0 Stop No effect

1: Setting No.1 Stop Release “Run – Stop” switch prohibition

2: Setting No.2 Stop + Prohibit “Run – 
Stop” switch Release “Run – Stop” switch prohibition

3: Setting No.3 Stop Run

Item Content Data type / range
IP Address IP address of the Web server Numeric value

Subnet Mask Subnet mask of the Web server Numeric value

Default Gateway Gateway of the Web server Numeric value

TCS-Net Relay Interface Q'ty Number of TCS-Net Relay Interface 1 - 12

Digital I/O Relay Interface Q'ty Number of digital I/O interfaces 0 - 8

Energy Monitoring Relay Interface Q'ty Number of energy monitoring interfaces 0 - 8

Item Content Data type / range
TCS-Net Relay Interface

Address Data Interface number 1 - 12

Energy Monitoring Relay Interface

Address Data Interface number 1 - 8

Digital I/O Relay Interface

Address Data Interface number 1 - 8

Item Content Data type / range
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Interface Setting Tab
The following table shows the settings configured on the Interface Setting tab:

Outdoor Tab
The following table shows the settings configured on the Outdoor tab:

Item Content Data type / range
Energy Monitoring Relay Interface

I/O Function Select the I/O function 0: No setting
4: Power Meter Signal Input

Pulse constants (kWh / pulse) Set the pulse constants 0.1 – 99.9

Digital I/O Relay Interface

I/O Function (Smart BMS Manager only) Select the I/O function
0: No setting
2: Door Lock Input
5: Demand

Signal logic Select the signal logic 0: negative logic
1: positive logic

Item Content Data type / range
LINE No / I/F No Select the line No. address 1 - 12

Line address Refrigerant line number 1 - 32

Outdoor unit combination model name Select the outdoor unit models

Outdoor unit model name Select the outdoor unit models

Outdoor name Enter the line name Characters (Up to 100 bytes, 
Forbidden:   ; : , #)

Outdoor unit address Unit number

Power meter input name Select the input name for energy monitoring No setting
WHE-1-1_1 - WHE-1-8_8
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Zone Tab
The following table shows the settings configured on the Zone tab:

Indoor Tab
The following table shows the settings configured on the Indoor tab:

Item Content Data type / range
Name Zone name Characters (Up to 100 bytes, Forbidden:   ; : , #)

Tally Classifications Select the tally classification

0: N/A
1: Common use area
2: Tenant
Monthly report tenant only

Monthly report tenant name Select the monthly report tenant 
name

None
Monthly report tenant name list
Tenant only

Item Content Data type / range
LINE No / I/F No Select the line No. address 1 - 12

Line Address Refrigerant line number 1 - 32

Indoor unit address Unit number 1 - 64

Parent Indoor Unit No. Number to distinguish parent and 
child

0: Parent
1 – 512: Child

Indoor unit model name Select from indoor unit models

R.C.group / indoor name Enter the line name Characters (Up to 100 bytes, Forbidden:   ; : , #)

Floor name Select the floor No setting
Floor name list

Tenant name Select the tenant No setting
Tenant name list

Area name Select the area No setting
Area name list

Door-lock input name Select the input name for lock 
linkage

No setting
DIO-1-1_IN-1 - DIO-1-8_IN-8

Power meter input name Select the input name for energy 
monitoring

No setting
WHE-1-1_1 - WHE-1-8_8

General purpose interface Energy 
Coefficient (kWh)

General purpose Interface energy 
coefficient Can be entered

Air Conditioner No. Air-conditioner number 1 - 512
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Demand Tab
The following table shows the settings configured on the Demand tab:

Set Tree Name Screen
The following table shows the settings configured on the Set Tree Name screen:

Item Content Data type / range
Indoor

Control Mode Indoor demand alarm setting

0: Stop
1: Maximum Save
2: 50% Save
10: Thermo Off (No Delay Cancel)
11: Thermo Off (10-sec Delay)
12: Thermo Off (20-sec Delay)
13: Thermo Off (30-sec Delay)
14: Thermo Off (60-sec Delay)
20: FAN

Item Content Data type / range
Outdoor

Control Mode Outdoor demand alarm setting
0
60
70

80
90

Item Content Data type / range
Zone 1 name Zone name - Floor Characters (Up to 30 bytes, Forbidden: ;  :  ,  #)

Zone 2 name Zone name - Tenant Characters (Up to 30 bytes, Forbidden: ;  :  ,  #)

Zone 3 name Zone name - Area Characters (Up to 30 bytes, Forbidden: ;  :  ,  #)
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Initializing the Icon Display file
The Icon Display data is saved to Touch Screen Controller (BMS-CT5120UL) itself. The Icon Display file 
initialization function has been added.
Perform the following procedure to initialize the Icon Display file.

1 Specify an IP address.

2 Select [Touch Screen Controller (BMS-CT5120UL)].

3 Select [Delete specific data].

4 Select [Icon Display].

5 Specify a backup folder. (Fig.368)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

6 Use the PING command to check the connection to the target system.

Fig.368 [Initialization Tool] screen

Fig.369 [Browse For Folder] screen

1 6

3 4

5

5

2
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7 Click the [Execute] button, or select the [Operation] menu then [Execute].

Fig.370 [Initialization Tool] screen (Execute button / Execute menu)

8 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.371 [Warning] screen

9 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.372 Progress bar
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Upgrading function
This function upgrades the Touch Screen Controller (BMS-CT5120UL).

Upgrade data
Upgrade data's file name is fixed “versionup.zip”. Don't change upgrade data's file name.

NOTE

Upgrading
Perform the following procedure to upgrade:

1 Specify an IP address.

2 Select the target system.

3 Specify a backup folder. (Fig.373)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.373 [Initialization Tool] screen

An upgraded function cannot be downgraded. The upgrade is performed by connecting the target device to a computer 
containing this software via a network. If the network is disconnected or the power is turned off during the upgrade, the 
system may malfunction.

1 4

3

3

2
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Fig.374 [Browse For Folder] screen

5 Select the [Tool] menu then [Upgrade].

Fig.375 [Initialization Tool] screen (Upgrade menu)

6 The Check Destination Folder screen appears.

7 Click the [Browse] button, and select the folder containing the Upgrade data on the displayed 
Browse For Folder screen (Fig.374).

8 Click the [OK] button.

Fig.376 [Check Destination Folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.377 [Warning] screen

10 Click the [OK] button.
The Upgrade starts, and the progress bar appears.

Fig.378 Progress bar

11 If the upgrade is completed successfully, the completion dialog box appears.
The version of the upgraded software appears.

Fig.379 Completion dialog box

Full data backup function
All the data of Touch Screen Controller (BMS-CT5120UL) can be backed up by [Tool] > [Full Backup].

Setting File Data Download
Setting File Creation Software Data (BMS-CT5120UL, BMS-SM1280HTLUL, BMS-STBN10UL) can be 
downloaded by [File] > [Setting File Data Download].
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Appendix D BN Interface (BMS-IFBN640TLUL)

Workflow of the Setting File Upload
The following flowchart shows the process of uploading Setting File with Setting File Creation Software for North 
America:

Setting Central address 
for Indoor Unit

BMS-IFBN640TLUL Cold 
Start

Trial Operation

Change Setting ?
IP Address or

C / F or
BACnet Setting

Create Data by Setting 
File Creation Software for 

North America

[Main Menu]>[Tool]>[IP Address 
Search]>[BACnet]>[BMS-

IFBN640TLUL]

Setting PC’s IP Address

[Data Input 
Main]>[Output File]

[Data Input 
Main]>[Upload]

Display completion dialog 
box and Reboot

Insert USB Flash drive to 
PC

[Data Input 
Main]>[Output DEF File 

to USB Flash drive]

Check “BNIF_Upload” 
folder in USB Flash drive

Insert USB Flash drive to 
BMS-IFBN640TLUL

Wait a few minutes and 
Reboot

Upload by
USB

Ethernet

*1 Refer to Indoor Unit’s owner’s Manual

*2 Refer to BN Interface’s Installation Manual

*1

*2

*2

Yes

No
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Workflow of the Setting check
The following flowchart shows the process of checking setting file with Setting File Creation Software for North 
America:

Insert USB Flash drive to PC

Insert USB Flash drive to BMS-IFBN640TLUL

Wait a few minutes

Insert USB Flash drive to PC

Finish Checking

[Main Menu]>[Tool]>[USB 
Mount for BN Interface]

Check “BNIF_Download” 
folder in USB Flash drive

Check Indoor unit total Q’ty by 
SearchObjectLog.tsv

Check IP Address Setting by 
Interfaces

Check BACnet Setting by to open ***.bac 
for Setting File Creation Software
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Using the Setting File Creation Software for North America

Starting / Exiting the Setting File Creation Software for North America
Starting the Setting File Creation Software for North America
Use the desktop icon or Windows menu to start the Setting File Creation Software for North America.

1 Start the Setting File Creation Software for North America.
• Desktop icon
Double-click the desktop icon.

Fig.380 Setting File Creation Software for North America desktop icon

• Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America].

2 The startup screen appears.
The startup screen appears.

Fig.381 Startup screen

3 Setting File Creation Software for North America Startup Complete.
The startup screen (Fig.381) disappears, and the Main Menu screen (Fig.2) appears. The Setting File Creation 
Software for North America startup is now complete, and the software can be operated.
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Exiting the Setting File Creation Software for North America
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.382 [Main Menu] screen (Close button)

Fig.383 [Main Menu] screen (Exit button)

Fig.384 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.385 Exit confirmation dialog box

Click button

Click button
206-EN– 206 –



Setting File Creation Software for North America Operating Instructions

207-EN
Creating New Data
Click the [New] button, or select the [File] menu then [New]. The Select System screen (Fig.3) appears.

Fig.386 [Main Menu] screen (New button 1)

Fig.387 [Main Menu] screen (New button 2)

Fig.388 [Main Menu] screen (New menu)

When the Open screen has opened, select a file to edit. The system screen (Fig.4) appears.

Fig.389 [Open] screen

Click button

Click button
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Using a History File to Edit Data
Double-click a line in the History List, or select a file from Recently Used File. The system screen (Fig.4) appears.

Fig.390 [Main Menu] screen (History List)

Double-click
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Up to 9 files are stored in Recently Used File.

Fig.391 [Main Menu] screen (Recently Used File)

If the selected file does not exist, a warning appears.

Fig.392 Warning message box
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Setting Up the System
Select the [System] tab and configure the settings.

Fig.393 [System] tab

The following table shows how to enter / select data:

Item Data type Selection Note
Building name Entered by user

Temperature display: Interval Selected by user Select from list

Temperature display: C./F. Selected by user Select from list

BACnet System with Smart BMS 
Manager Series Selected by user Select from list

BACnet System with Touch Screen 
Controller (BMS-CT5120E/UL) Selected by user Select from list

Receive UDP Port Entered by user Numeric value only 47808 - 47823
49152 - 65535

Transmit UDP Port Entered by user Numeric value only 47808 - 47823
49152 - 65535

Device instance Number additional 
value Selected by user Select from list

Instance Number Setting Entered by user Numeric value only 0 - 4194303

Select Coldstart / Warmstart Selected by user Select from list

Table.20 How to enter / select data
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Setting Up the Server
Select "Server Setting" on the "Server / Interface" tab and set the number of interfaces and the IP address of the 
BN Interface.
On the BACnet, when the server’s IP address is uploaded it is automatically edited according to the IP address, 
subnet mask, and default gateway information set in this tab.

Fig.394 [Server Setting] tab

The following table shows how to enter / select data:

Item Data type Selection Note
IP Address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Default Gateway Entered by user Numeric value only

Table.21 How to enter / select data
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Adding an RegisterForeignDevice
Select the in [RegisterForeignDevice] tab in [Control Setting (Communication)] tab, and click [Add] button.
After a click, a line is added to the list. Configure the settings for BBMD (BACnet/IP Broadcast Management 
Device). A maximum of 10 lines can be registered.

Fig.395 [RegisterForeignDevice] tab

The following table shows how to enter / select data:

Item  Data type Selection Note
IP address Entered by user Numeric value only

Subnet Mask Entered by user Numeric value only

Port Number Entered by user Numeric value only

Transmission Interval (second) Entered by user Numeric value only 60~65535

Click button
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Deleting the Data of RegisterForeignDevice
Select one or more lines of Foreign BACnet Device, click the [Delete] button.

Fig.395-1 [RegisterForeignDevice] tab ([Delete] button)

The deletion confirmation dialog box appears.
Click the OK button to delete. The line will be deleted from the list. To cancel deletion, click the Cancel button.

Fig.395-2 Deletion confirmation dialog box

Click button
– 213 –



Setting File Creation Software for North America Operating Instructions

EN
Saving Created Data to a File
Click the [Save] button, or select the [File] menu then [Save Setting File] or [Save Setting File As].

Fig.396 [Save] button

Fig.396-1 [Save Setting File] menu

Fig.396-2 [Save Setting File As] menu

Click button
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When a new file is created or the menu [Save Setting File As] is selected, the [Save As] screen appears. Select a 
destination folder and enter a file name.

Fig.397 [Save As] screen

When the data is to be saved to an existing file, the overwrite confirmation dialog box appears. Click the OK button 
to overwrite the file. To cancel saving and return to the data input screen, click the Cancel button.

Fig.398 Overwrite confirmation dialog box
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Outputting Files
Click the [Output File] button, or select the [File] menu then [Output DEF File].

Fig.399 [Output File] button

Fig.400 [Output DEF File] menu

The overwrite confirmation dialog box appears. Click the OK button to Overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.401 Overwrite confirmation dialog box

Click button
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The Browse For Folder screen appears. Select a destination folder to save the DEF file to.

Fig.402 [Browse For Folder] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.403 Example of error message box

When the DEF file output is complete, a message appears. Select the “Start up the upload screen.” checkbox and 
click the OK button. The upload screen appears.

Fig.404 DEF file output complete dialog box
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Deleting a File History
You can delete a selected history item or all the history items.
• Delete Selected History
• Delete All

Fig.405 [Main Menu] screen (Delete History)

The deletion confirmation dialog box appears.
Click the OK button to delete. The history item will be deleted from the History List. To cancel deletion, click the 
Cancel button.

Fig.406 Deletion confirmation dialog box
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Search for the BN Interface on the network
If you do not know the IP address of the BN Interface on the network, click the [Tool]>[IP Address 
Search]>[BACnet]>[BMS-IFBN640TLUL].

Fig.407 [IP Address Search for the BN Interface]

A dialog box appears before the search starts to confirm you want to execute the search. To execute the search, 
click the [Device Search] button.

Fig.408 [IP Address Search]

When the search is complete, appears IP address. To exit this dialog box, click the [Close] button.

Fig.409 [IP Address Search]
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Uploading a setting file (DEF File)

Uploading a Setting File (DEF File)
Click the [Upload] button or select the [File] menu then [Upload] on the [Main Menu] screen (Fig.2) or [Data Input 
Main] screen (Fig.4). The Upload Settings screen (Fig.14) appears.

Fig.410 [Main Menu] screen (Upload button)

Fig.411 [Main Menu] screen (Upload menu)

Fig.412 [Data Input Main] screen (Upload button)

Fig.413 [Data Input Main] screen (Upload menu)

Click button

Click button
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Specifying Setting File Data
Specify the setting file data to upload.

Fig.414 [Upload Settings] screen (Specify file directly)

Select a file on the Open screen.

Fig.415 [Open] screen

Click button
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Specifying a Setting File Folder
Select a folder.
When setting file data is specified, the folder is automatically selected depending on the setting.

Fig.416 [Upload Settings] screen (Specify folder directly)

Select a folder containing the setting file on the Browse For Folder screen.

Fig.417 [Browse For Folder] screen

Click button
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Specifying a Target System (type and model name)
Select a destination system to upload the file to.
When Setting File Data is specified, the target system is automatically set to “BACnet” & “BMS-IFBN640TLUL”.

Fig.418 [Upload Settings] screen (Type, Model Name)

Specifying an IP Address

Fig.419 [Upload Settings] screen (IP Address)
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The following table shows the items in the File List:

Starting the Upload
After the preparation (Specifying Setting File Data) has been completed, click the Upload button. The upload starts.

Fig.420 [Upload Settings] screen (Upload button)

The progress bar is displayed during the upload.

Fig.421 Progress bar

CAUTION

Item Content
File Name Name of the file to upload

Size Size of the file to upload

Last Updated Last updated time of a file to upload

File
Shows whether a setting file exists in the specified folder
Yes: Exists
No: Does not exist

If BACnet server is shut down during upload, stored data may be damaged and the server may not operate.
Do not shut down the server during upload.

Click button
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Uploading a setting file(DEF File) by the USB Flash Drive
Click the [Output DEF File to USB Flash drive] button or select the [File]>[Output DEF File to USB Flash drive] on 
the [Data Input Main] screen.

Fig.422 [Data Input Main] screen (button)

Fig.423 [Data Input Main] screen (menu)

The overwrite confirmation dialog box appears. Click the OK button to overwrite the file. To cancel saving and 
return to the data input screen, click the cancel button.

Fig.424 Overwrite confirmation dialog box
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Select a USB Flash Drive to save the DEF file to.

Fig.425 [Select USB Flash drive] screen

The entered data will be checked. If the data contains an error, the item and error message box appear. Modify the 
section containing the error.

Fig.426 Example of error message box

When the DEF file output is complete, a message appears. Click OK button.

Fig.427 DEF file output complete dialog box
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Check "BNIF_Upload" folder in USB Flash drive.

Fig.428 Example of USB Flash Drive

Insert the USB Flash Drive to BMS-IFBN640TLUL's USB Port.
Wait about 2 minutes, Setting files update to BMS-IFBN640TLUL and reboot. 

Checking Setting File
Select the [Tool]>[USB Mount for BN Interface] on the [Main Menu] screen.

Fig.429 [Data Input Main] screen (button)

Select a USB Flash Drive to download the Setting File of BMS-IFBN640TLUL.

Fig.430 [Select USB Flash drive] screen
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When the USB Flash Drive Mount is complete, a message appears. Click OK button.

Fig.431 USB Flash Drive Mount complete dialog box

Check "BNIF_Download" folder in USB Flash drive.

Fig.432 Example of USB Flash Drive

Insert the USB Flash Drive to BMS-IFBN640TLUL's USB Port.
Wait about 1 minute, BMS-IFBN640TLUL's Setting files download to USB Flash Drive.
Insert the USB Flash Drive to PC and check "BNIF_Download" folder. There are "SearchObjectLog.tsv", 
"Interfaces", "*****.bac" files.

Fig.433 Example of USB Flash Drive
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Check the Indoor Unit total Q'ty by the "SearchObjectLog.tsv".

Fig.434 Example of "SearchObjectLog.tsv"

Check the IP Address, Subnet Mask, Default Gateway by the "Interfaces".

Fig.435 Example of "Interfaces"
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Check the BACnet Setting by the "*****.bac".

Fig.436 Example of "*****.bac"
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System settings

System Tab
The following table shows the settings configured on the System tab:

Server Setting Tab
The following table shows the settings configured on the Server Setting tab:

Control Setting(Communication)

RegisterForeignDevice
The following table shows the settings configured on the RegisterForeignDevice tab:

Item Content Data type / range

Building name Building name Characters (Up to 100 bytes,
Forbidden: “ ' > < : ; , # &)

Temperature display: Interval Unit of temperature interval 0: Unit 1 °C.
1: Unit 0.5 °C.

Temperature display: C./F. Celsius 0: °C.
1: °F.

BACnet System with Smart BMS Manager 
Series

Concomitant use
Smart BMS Manager void/valid

0: Void
1: Valid

BACnet System with Touch Screen 
Controller (BMS-CT5120E/UL)

Concomitant use
Touch Screen Controller void/
valid

0: Void
1: Valid

Receive UDP Port Receive UDP Port number 47808 - 47823, 49152 - 65535

Transmit UDP Port Transmit UDP Port number 47808 - 47823, 49152 - 65535

Device instance Number additional value

0: Use 1 byte of Last byte of IP address 
number

1: Use 2 byte of 3 and 4 byte of IP 
address number

2: User setting

Instance Number Setting Instance number 0 - 4194303

Select Coldstart / Warmstart Selection of the Coldstart or 
Warmstart after uploading

0: Coldstart
1: Warmstart

Item Content Data type / range
IP Address IP address of the server Numeric value

Subnet Mask Subnet mask of the server Numeric value

Default Gateway Gateway of the server Numeric value

Item Content Data type / range

IP address IP address of the Foreign 
Device(BBMD) Numeric value

Subnet Mask SubnetMask of the Foreign 
Device(BBMD) Numeric value

Port Number Port Number of the Foreign 
Device(BBMD) Numeric value

Transmission Interval (second) Transmission Interval time 
for the Foreign Device(BBMD) 60 - 65535
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Initialization tool
There is an initialization function to return the system to the factory settings, a function to download setting 
information from the BACnet local server, and a function to update versions of the BACnet local server software.

Starting the Initialization Tool
Use the menu of the Setting File Creation Software for North America or Windows menu to start the Initialization 
Tool.
Menu of the Setting File Creation Software for North America

Fig.437 [Main Menu] screen (Initialization Tool)

Windows menu
Select [Start] > [All Programs] > [Toshiba] > [Setting File Creation Software for North America] > [Initialization Tool].
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Exiting the Initialization Tool
Click the [Close] button, the Exit button, or select the [File] menu then [Exit].

Fig.438 [Main Menu] screen (Close button / Exit button)

Fig.439 [Main Menu] screen (Exit menu)

The exit confirmation dialog box appears.
Click [Yes] to exit, or [No] to cancel exiting.

Fig.440 Exit confirmation dialog box

Click button
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Initializing a system
You can reset a target system to its default settings. All data in the system will be deleted.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a backup folder. (Fig.441)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.441 [Initialization Tool] screen

Fig.442 [Browse For Folder] screen
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5 Select the [Tool] menu then [System Initialization].

Fig.443 [Initialization Tool] screen (System Initialization menu)

6 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.444 [Warning] screen

7 Click the [OK] button.
The initialization starts, and the progress bar appears.

Fig.445 Progress bar

8 If the initialization is completed successfully, the completion dialog box appears.

9 Restart the target system.
Press the reset button, or turn off the power and turn it back on again. When the power is turned off, wait until 
over a minute passes before turning it back on.

Fig.446 Completion dialog box
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Downloading data
You can download setting data from the BACnet local server.
Follow the procedure below:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a folder in which to download. (Fig.448)
Specify a folder in which to save the files downloaded from the BACnet local server. If you do not specify a 
folder, files are saved to "C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup", in Windows XP or to "C:\Program Data\Toshiba 
CarrierCorporation\Initialization Tool\backup", in Windows Vista/7. This folder is a hidden folder. To show the 
folder, you need to change the "Folder Options" settings.

4 Use the PING command to check the connection to the target system.

Fig.447 [Initialization Tool] screen

Fig.448 [Browse For Folder] screen
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5 Select the [Tool] menu then [Download].

Fig.449 [Initialization Tool] screen (Download menu)

6 The download starts and the progress bar appears.

Fig.450 Progress bar

7 If the download is completed successfully, the completion dialog box appears.

Fig.451 Completion dialog box
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Upgrading
This function upgrades the software of the BN Interface.

Upgrade data
Upgrade data’s file name is fixed “versionup.zip”. Don’t change upgrade data’s file name.

NOTE

Perform the following procedure to upgrade:

1 Specify an IP address.

2 Select the target system (type and model name).

3 Specify a backup folder. (Fig.452)
A backup folder can be specified before initializing a setting file. If you do not specify a backup folder, the data 
will be backed up to “C:\Documents and Settings\All Users\Application Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows XP, or “C:\Program Data\Toshiba Carrier 
Corporation\Initialization Tool\backup” in Windows Vista/7. This folder is a hidden folder. To show the folder, 
you need to change the “Folder Options” settings.

4 Use the PING command to check the connection to the target system.

Fig.452 [Initialization Tool] screen

An upgraded function cannot be downgraded. The upgrade is performed by connecting the target device to a computer 
containing this software via a network. If the network is disconnected or the power is turned off during the upgrade, the 
system may malfunction.
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Fig.453 [Browse For Folder] screen

5 Select the [Tool] menu then [Upgrade].

Fig.454 [Initialization Tool] screen (Upgrade menu)

6 The Check Upgrade folder screen appears.

7 Click the [Browse] button, and select the folder containing the Upgrade data on the displayed 
Browse For Folder screen (Fig.453).

8 Click the [OK] button.

Fig.455 [Check Upgrade folder] screen
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9 Read the displayed warning message, and select the [Understand these warning messages and 
then perform the processing] checkbox.

Fig.456 [Warning] screen

10 Click the [OK] button.
The Upgrade starts, and the progress bar appears.

Fig.457 Progress bar

11 If the upgrade is completed successfully, the completion dialog box appears.
The version of the upgraded software appears.

Fig.458 Completion dialog box
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